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Formattazione

Testo e stile del contenuto

Una volta che il testo e le immagini sono stati raccolti in un unico file, usa
Stili e Titoli per creare un aspetto coerente per i titoli di testo e sezioni.
Utilizza le interruzioni di pagina invece del ritorno a capo o delle interruzioni
di paragrafo per garantire la conservazione della formattazione durante

la creazione del file PDF per la stampa. Applica regole di spaziatura
personalizzate agli stili per mantenere un aspetto coerente in tutto il libro. U
uso degli stili ti consente di modificare contemporaneamente tutto il testo
assegnato a quello stile, anziché modificarlo riga per riga.

Opzioni di colore per il contenuto

La necessita della stampa a colori deve essere considerata nelle prime fasi
del processo di formattazione. La tua opera contiene solo testo? In questo
caso, puoi approfittare dei nostri prodotti bianco o crema, 60# bianco e
nero non patinato standard per ridurre i costi di produzione. Per immagini
ad alto contrasto e in scala di grigi, Lulu offre un bianco, 80# bianco e nero
patinato standard. | nostri prodotti bianco, 60# colore standard non
patinato permettono diincorporare elementi interessanti come caratteri
colorati, evidenziazioni, grafici, grafiche, piccole foto o blocchi di colore

a bassa pigmentazione/saturazione nel lavoro stampato, senza il costo
premium.

Se desideri una stampa a colori della massima qualita, 'opzione Colori
Premium offre la qualita necessaria per le foto ad alta risoluzione e la
copertura delle pagine con margini al vivo. Disponibile su carta bianca,
80# patinata e non patinata, ti consente di controllare il prezzo, offrendo
comunque splendide immagini e colori vivaci.
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Confronto della risoluzione dell'immagine

300 PPI

La risoluzione standard Risoluzione minima per la Risoluzione ideale per
per la maggior parte delle grafica semplice destinata grafiche complesse o
grafiche visualizzate nella alla stampa. dettagliate destinate alla
versione digitale. stampa.

Risoluzione fotografica e grafica

| pixel per pollice (PPI) sono utilizzati per descrivere la densita di pixel di
uno schermo (monitor del computer, smartphone, ecc.). | punti per pollice
(DP)) si riferiscono alla risoluzione di stampa di un'immagine contando

il numero di punti per pollice stampato. Maggiore € il numero di punti,
migliore € la qualita della stampa (maggiori sono la nitidezza e il dettaglio).
La maggior parte dei formati di file pronti per la stampa sanno come gestire
la conversione tra PPl e DPI. | PDF ti consentono anche di avere file pronti
per la stampa con valori PPl multipli, ma € opportuno considerare i risultati
desiderati prima di inserire qualsiasi dimensione dellimmagine.

72 PPI ¢ larisoluzione standard per la maggior parte degli schermi. Puo
essere adatta per le immagini digitali, ma il testo e i dettagli della grafica
potrebbero finire per apparire distorti o sfocati nella stampa. Come regola
generale, consigliamo un minimo di 150 PPI per la grafica semplice e di 300
PPI per la grafica complessa o dettagliata.
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Impostazione del colore del documento

RGB & un processo additivo, nel senso che aggiunge rosso, verde e blu
insieme in quantita variabile per produrre altri colori, mentre CMYK & un
processo sottrattivo che utilizza diverse quantita di ciano, magenta, giallo e
nero per rimuovere i colori riflessi dalla carta al fine di creare altri colori che
possiamo vedere. | due processi hanno diverse gamme di colore, con RGB
che fornisce una pit ampia varieta di possibilita; ecco perché viene utilizzato
in dispositivi elettronici come i monitor dei computer. La stampa utilizza
invece il CMYK.

E risaputo che bisogna convertire i colori RGB in CMYK prima di mandare i
file stampa. Si tratta in realta di una vecchia pratica che puo essere seguita
senza problemi, ma i progressi compiuti nei flussi di lavoro di stampa non la
rendono pil necessaria.

Perché i modelli di Adobe InDesign sono configurati in RGB?

I moderni flussi di lavoro, come i processi adottati da Lulu, permettono

alle stampanti di utilizzare profili di colore che abbinano automaticamente
l'inchiostro CMYK ai valori RGB per produrre risultati simili. Seguendo queste
poche e semplici linee guida, potrai ottenere il miglior colore possibile
allinterno del libro:

1. Se parti da zero, imposta il documento come file RGB.

2. Consigliamo di utilizzare lo spazio colore sRGB nel profilo colore
del documento RGB e di applicare lo spazio colore sRGB a qualsiasi
immagine RGB o link prima di creare il PDF per la stampa.

3. Se hai gia creato o convertito il file in CMYK e convertito le immagini
in CMYK, non & necessario passare di nuovo a RGB. La modifica delle
impostazioni dello spazio colore dopo la finalizzazione del file puo
causare variazioni di colore indesiderate.

4. lInerointinta unita € composto da nero al 100%, senza colori aggiunti.
Se aggiungi dei colori per arricchire il nero, il limite di copertura totale
dell'inchiostro (TAC) non deve superare il 270%.

5. Evita di creare colori molto chiari, con una retinatura al di sotto del 20%4.
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Non ¢ facile gestire in modo preciso le tonalita con retinatura inferiore
al 20%.

6. Se stampiun libro a colori che contiene immagini in bianco e
nero, l'impostazione del metodo del colore delle immagini deve
corrispondere alla scala di grigi.

7. Lagamma della scala di grigi dellimmagine deve essere compresa tra
22e24.

8. Utilizza solo foto ad alta risoluzione (300 DPI o superiore) e assicurati
che siano coerenti con o spazio colore del documento, a prescindere
dall'utilizzo di RGB o CMYK.

9. Utilizza la stampa Colori Premium per I'lnterno del libro e la carta
Premium 80# quando stampi libri contenenti foto o grafica con una
copertura di inchiostro importante e desideri un libro stampato vivace e
ricco di colori.

Profili spazio colore stampante Lulu:

I B B RGB:sRGBIEC61966—2.1
Bl B CMYK:Coated GRACoL 2006

LULU GUIDA ALLA CREAZIONE DI UN LIBRO CREAZIONE DEL FILE



Anatomia di un libro

Qulu Qulu

RETRO COPERTINA FRONTE COPERTINA

Copertina del libro

Niulu

INTERNO

:Co:nténu:to:de:l lil:)ro:
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Termini di formattazione

Dimensioni totali del documento
Le dimensioni totali del file con margine di pagina al vivo (bleed) incluso.

Area del dorso

La larghezza del dorso varia in base al numero di pagine incluse nel libro. Usa
la formula o la tabella appropriata per determinare la larghezza del dorso per
i libri a copertina morbida e rigida. | libri con rilegatura a spirale e cucita non
sono incollati al dorso, quindi non richiedono calcoli particolari.

Margine di sicurezza

Ti consigliamo di mantenere un bordo tra il margine di taglio e il contenuto
importante (ad esempio, testo, immagini, numeri di pagina) per evitare che tali
elementi vengano erroneamente ritagliati.

| Area pagina al vivo (bleed)
Durante la produzione, viene rifilato un bordo dalle pagine del libro stampato.
Immagini, testo o altri elementi che dovrebbero andare oltre il bordo della
pagina devono rientrare all'interno dellarea della pagina al vivo (bleed). Se un
file viene caricato senza un margine al vivo, Lulu deve aggiungere un margine
di0125in (3175 mm) su tutti i lati per una corretta rifilatura e rilegatura.
Consulta la sezione “Dimensioni del file e margini di pagina al vivo” (pagina 17).

Area del codice a barre (opzionale)

Larea consigliata in cui € inserito I''SBN. | libri non destinati alla Distribuzione
Globale non richiedono un codice a barre o ISBN. Lulu non genera o inserisce
per te il codice a barre o codice ISBN.

Margine (@ pagina 10)
[margine interno delle pagine, che consente di piegare la pagina. Consulta la
sezione ‘Aggiunte di margine per la rilegatura” (pagina 10).
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Area del margine di rilegatura

Qiulu Qiulu

INTERNO INTERNO

Aggiunte di margine di rilegatura

Siriferisce a uno spazio leggermente superiore sul lato di rilegatura

delle pagine frontali riservata alla porzione di pagina inserita e incollata
nella rilegatura del libro. | libri con rilegatura a spirale non richiedono un
margine. Se il tuo libro ha pit di 150 pagine, ti consigliamo di aggiungere un
margine per la rilegatura. Se crei un libro tascabile o con copertina rigida, fai
riferimento alla tabella delle aggiunte di margine dirilegatura:

Margine interno
consigliato (al
vivo)

Numero di Aggiungi a Margine interno

pagine margine interno consigliato

Meno di 60 0"o0Omm 0,5"013 mm 0,625"0 16 mm
Da61a150 0,125"0 3 mm 0,625"0 16 mm 0,75"0 19 mm
Da 151 a 400 0,5"013 mm 1"025mm 1,125"029 mm
Da 400 a 600 0,625"0 16 mm 1,125"029 mm 1.25"032mm
Oltre 600 0,75"0 19 mm 1,25" 032 mm 1,375"0 35 mm
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Quando utilizzare le dimensioni di margini di pagina al vivo

Non necessario Si Si
Se l'opera € composta Quando la grafica o il E importante preparare il file
principalmente da testo o contenuto si estende di stampa con dimensioni
ha margini bianchi distinti oltre il bordo della pagina, dei margini di pagina al vivo
intorno al corpo, le dimensioni € necessario utilizzare le per accenti e grafiche che
dei margini di pagina al vivo dimensioni dei margini di si estendono fino al bordo
non sono necessarie. pagina al vivo durante la della pagina.

preparazione del file.

Dimensioni del file e margini di pagina al vivo

Nella realizzazione di un libro, i file vengono stampati e poi rifilati in base

alle specifiche. Tutti i file dei libri vengono stampati con una dimensione
maggiore di 0,125" (3,175 mm) su tutti i lati rispetto alla dimensione di
taglio finale, in modo da tener conto del processo di rifilatura. Per gli accenti
al bordo di pagine, sfondi e file, i risultati migliori sono dati dalla rifilatura della
struttura della pagina.

Se il file formattato non include immagini che si estendono fino al bordo
della pagina, puoi preparare il file con le dimensioni finali del libro e il nostro
sistema aggiungera automaticamente un bordo di taglio.

Se il file formattato include grafici, file o contenuti che si estendono fino al
bordo della pagina, usa il grafico seguente per determinare le dimensioni
ideali del file del contenuto.

Nota: se una pagina del contenuto prevede margini al vivo, tutte le pagine
useranno le stesse dimensioni.
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Nome del taglio

Libro tascabile

Digest

AS

Regale

US Trade

Giornale a
fumetti

Executive

Testo in quarti

Quadrato
piccolo

A4

Quadrato

Lettera US

Orizzontale
piccolo

Lettera US /
Orizzontale

Orizzontale A4

Calendario

Dimensione del
taglio

4,25x6,875"
108 mmx 175 mm

55x8,5"
140mmx 216 mm

583x827"
148 mmx 210 mm

6,14x9,21"
156 mmx 234 mm

6x9"
152mmx 229 mm

6,63x10,25"
168 mmx 260 mm

7x10"
178 mmx 254 mm

744 x9,68"
189 mmx 246 mm

7,5x7,5"
19T mmx 197 mm

8,27 x11,69"
210mmx 297 mm

85x8,5"
216 mmx216 mm

85x 11"
216 mmx279 mm

Ox7"
229 mmx 178 mm

11x85"
279mmx216 mm

11,69x8,27"
210 mmx 297 mm

11x85"
279mmx216 mm

Dimensioni del

file del contenuto:
senza margini al vivo

4,25x6,875"
108 mmx 175 mm

55x8,5"
140mmx216 mm

583x827"
148 mmx 210 mm

6,14x9,21"
156 mmx 234 mm

6x9"
152mmx 229 mm

6,63x10,25"
168 mmx 260 mm

7x10"
178 mmx 254 mm

744 x9,68"
189 mm x 246 mm

7,5x75"
19T mmx 197 mm

8,27 x11,69"
210mmx 297 mm

85x8,5"
216 mmx216 mm

85x 11"
216 mmx279 mm

9x7"
229 mmx 178 mm

11x85"
279mmx216 mm

11,69 x8,27"
210 mmx 297 mm

11x85"
279mmx216 mm

Dimensioni del file
del contenuto: con
margini al vivo

45x7,125"
174mmx 1817 mm

5,75x8,75"
146 mmx 222 mm

6,08 x8,52"
154mmx216 mm

6,39 x9,46"
162 mmx 240 mm

6,25x9,25"
159 mm x 235 mm

6,88x10,5"
175mmx 267 mm

7,25x10,25"
184 mmx 260 mm

7,69 x9,93"
195mmx 252 mm

7,75x7,75"
197 mmx 197 mm

8,52x11,94"
216 mm x 303 mm

8,75x8,75"
222 mmx 222 mm

8,75x11,25"
222 mm x 286 mm

9,25x7,25"
235mmx 184 mm

11,25x8,75"
235mmx 184 mm

11,94 x8,52"
303 mmx216 mm

11,25x8,75"
286 mm x 222 mm
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Layout di copertina

Copertina generata da Lulu

Il nostro sistema inserisce le informazioni che ci fornisci per creare una
copertina accattivante, completa di titolo, sottotitolo, collaboratore/i e
descrizione. Si tratta di un‘opzione ottima e veloce quando hai poco tempo a
disposizione o hai semplicemente bisogno di alcune copie di prova.

Creazione e caricamento della tua copertina

Una volta che hai caricato il file del contenuto, generiamo un modello

di copertina che puoi scaricare e che viene personalizzato secondo le
specifiche del tuo libro. Creando la tua copertina, avrai il pieno controllo del
contenuto.

Guida relativa alla larghezza del dorso

La larghezza del dorso della copertina & determinata dal tipo dilibro da
realizzare e dal numero di pagine totali. Le copertine morbide richiedono un
minimo di 32 pagine di contenuto e la larghezza del dorso viene calcolata
attraverso una formula. Le copertine rigide richiedono un minimo di 24
pagine di contenuto e la larghezza del dorso si basa su una tabella con
intervalli di pagine.

Nota: una volta caricato il PDF del contenuto con le dimensioni del dorso
incluse, Lulu fornisce un modello di copertina.
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Calcoli per la larghezza del dorso

Copertine morbide
Usa la formula per calcolare la dimensione della larghezza del

dorso in pollici o millimetri.

Larghezza del dorso in pollici =
(n° delle pagine interne / 444) + 0,06"

Larghezza del dorso in millimetri =
(n° delle pagine interne / 17,48) + 1,524 mm

Copertinerigide
Usa la tabella per determinare la dimensione della

@ METRICO [l IMPERIALE

larghezza del dorso.

Numero di pagine Larghezza figl dorso Larghezza del dorso
(pollici) (mm)
0-23 N/D N/D
*24-84 025" 6 mm
85-140 055" 13 mm
141-168 0,625" 16 mm
169-194 0,688" 17 mm
195-222 0,75" 19 mm
223-250 0813" 21 mm
251-278 0.875" 22 mm
279-306 0,938" 24 mm
307-334 1 25mm
335-360 1,063" 27 mm
361-388 1,125" 29 mm
389-416 1,188" 30 mm
417-444 1,25" 32mm

LULU GUIDA ALLA CREAZIONE DI UN LIBRO CREAZIONE DEL FILE
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Larghezza del dorso Larghezza del dorso

Numero di pagine

(pollici) (mm)
445-472 1,313" 33mm
473-500 1,375" 35mm
501-528 1,438" 37 mm
529-556 15" 38 mm
557-582 1,563" 40 mm
583-610 1,625" 41 mm
611-638 1,688" 43 mm
639-666 1,75" 44 mm
667-694 1.813" 46 mm
695-722 1,875" 48 mm
723-750 1,938" 49 mm
751-778 2" 51 mm
779-799 2,063" 52 mm
800 2,125" 54 mm

Regolazione della larghezza del dorso

Lulu offre modelli in diversi formati che permettono la creazione di copertine
nel software con cui hai maggiore dimistichezza. Di seguito € riportata

una breve descrizione di come regolare la larghezza del dorso con Adobe
InDesign o Adobe Photoshop. | modelli sono disponibili anche in formato
PDF e PNG. Ogni modello del dorso del modello di copertina € preimpostata
alla dimensione minima della larghezza. Tienilo presente quando modifichi il
dorso.

Adobe InDesign
Utilizza il page toool per regolare la larghezza del dorso.

1. Individua Page Tool nel pannello degli strumenti e selezionalo.

2. Nel pannello delle pagine, fai clic sulla pagina del dorso (pagina 2 del
documento). La pagina sara evidenziata nel pannello delle pagine.
Specifica le seguenti impostazioni nel pannello di controllo Liguid
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Layout (Window > Interactive > Liquid Layout):

M Liquid Page Rule: Object-based
M Object Constraints: Resize with Page: Width

3. Dopo aver determinato le dimensioni del dorso utilizzando la formula
(copertina morbida) o la tabella di calcolo (copertina rigida) riportata
in guesto PDF ridimensiona la pagina tramite i widget Height e Width
nella barra di controllo. Lintera copertina dovrebbe aggiornarsi
automaticamente ed essere quindi pronta per ospitare l'artwork.

Nota:il documento deve essere configurato con l'opzione pagine
afflancate selezionata per il posizionamento automatico della copertina.

Adobe Photoshop
Regola le dimensioni dellarea di lavoro, verifica la larghezza del
dorso e posiziona le guide per la copertina.

1. Sottrai la dimensione minima della larghezza del dorso esistente
elencata sulla copertina dalla dimensione del dorso trovata utilizzando
la formula (copertina morbida) o la tabella di calcolo (copertina rigida)
riportata in questo PDF e aggiungi tale valore alla dimensione dell'area
dilavoro. Vai a Image > Canva Size ¢ inserisci la dimensione della
larghezza complessiva rivista.

2. Utilizza lo strumento di selezione del percorso per selezionare il livello
della forma del dorso nella cartella delle guide e inserisci la dimensione
della larghezza corretta trovata usando la formula o la tabella di calcolo
del dorso.

3. Allinea al centro la guida del dorso, a destra la guida della copertina
e a sinistra la guida della quarta di copertina rispetto al documento.
Assicurati che i livelli della guida siano posizionati correttamente e che
non vi siano problemi.
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Progettazione del dorso

La posizione del dorso puo variare leggermente durante la produzione.
Per consentire variazioni minime, invitiamo gli autori ad attenersi a queste
linee guida durante la creazione della copertina, soprattutto nella fase di
preparazione del dorso.

1. Nonincludere testo che vada a occupare l'intera larghezza del dorso.
Leventuale spostamento potrebbe far finire il testo del dorso nella
copertina o nella quarta di copertina. Lascia almeno 0,125" (3,175 mm)
tra il testo del dorso e il bordo su entrambi i lati del testo.

2. Nonincludere testo su progetti con un numero di pagine uguale o
inferiore a 80. Per i libri con poche pagine, il minimo spostamento
del dorso fara finire il testo del dorso nella copertina o nella quarta di
copertina.

3. Bvita di usare immagini o colori solidi e di forte contrasto i cui bordi
terminano in prossimita del dorso nella copertina o nella quarta di
copertina. Mantieni il dorso del libro dello stesso colore e della stessa
grafica del resto della copertina.

4. Seildorso avra un colore diverso dal resto della copertina, progetta il
tutto in modo da includere intenzionalmente la grafica o il colore del
dorso nella copertina e nella quarta di copertina.

Rifilatura e varianza

Quando progetti il contenuto e la copertina, devi prendere in considerazione
delle tolleranze. Durante la creazione del file, attieniti alle linee guida seguenti
per assicurarti che il progetto venga stampato correttamente. La nostra
tolleranza in termini di rifilatura & di 0,125" (3,175 mm) per la copertina e la
quarta di copertina. Progettare il contenuto tenendo presenti variazioni e
margini sufficienti ti aiutera a evitare problemi con l'allineamento del testo del
dorso e con eventuali porzioni di testo tagliate lungo i bordi del contenuto.

| Bordo di taglio
Si tratta del bordo del libro stampato e definitivo.
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Bordo al vivo

Le immagini devono essere spinte verso il bordo al vivo, 0,125" (3,175 mm)

oltre il bordo di taglio su ogni lato.

I Bordo di sicurezza

Il testo e gli altri elementi importanti devono essere posizionati all'interno

del bordo di sicurezza, che € paria 0,5" (12,7 mm) all'interno del bordo di

taglio. In questo modo, si garantisce che nessun testo venga tagliato a

causa di variazioni nel processo di rifilatura.

Esempi di copertina sottoposta a variazione di taglio (pagine 79-27)

Borders. Boundaries. Limits. Life is a continual process of
crossing borders and discovering something new. Collected
from a short fiction and non-fiction contest sponsored by Lulu
Press, the Crossing Borders Anthology contains stories about
overcoming obstacles; of physical, spiritual, and
emotional change and growth
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Corretto

Limmagine di sfondo ¢ stata estesa di 0,125" (3,175 mm) oltre il bordo di
taglio e sia il testo che le immagini importanti sono all'interno del bordo di

sicurezza.
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LULU GUIDA ALLA CREAZIONE DI UN LIBRO

Limmagine di sfondo non & stata estesa verso il bordo al vivo. Cio potrebbe
provocare la visualizzazione di strisce bianche attorno ai bordi della copertina.

Borders. Boundaries. Limits. Life is a continual process of |

crossing borders and discovering something new. Collected |

from a short fiction and non-fiction contest sponsored by Lulu

Press, the Crossing Borders Anthology contains stories about | 1)1
|
|
|

overcoming obstacles; of physical, spiritual, and
emotional change and growth
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Il testo della quarta di copertina e il testo del dorso non sono stati mantenuti

allinterno del bordo di sicurezza. Cio potrebbe comportare un'eliminazione
di parte del testo a causa delle tolleranze durante la rifilatura.
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Preparazione del file

Quando carichiil file del contenuto nel sistema di Lulu, scansioniamo e
analizziamo I'idoneita della tua opera per la stampa. In presenza di piccole
imprecisioni, apporteremo alcuni piccoli cambiamenti. Talvolta il nostro
sistema determina tuttavia la necessita di cambiamenti piti importanti. In tal
caso, ti avviseremo. Ti consigliamo caldamente di scaricare e controllare
i tuoi file pronti per la stampa prima di completare il processo di
pubblicazione.

g Come utilizzare le opzioni Adobe PDF (job options) di
Lulu

Quando si crea un PDF con i prodotti Adobe, utilizzare le
opzioni dilavoro Adobe PDF di Lulu (Jib options). | file di opzione
applicano impostazioni predefinite quando si esportano i PDF
in base ai requisiti dei nostri centri stampa. | file delle opzioni
(impostazioni di una pagina singola per l'interno e di una doppia
pagina per la copertina) sono inclusi nei modelli di design Lulu
nella nostra pagina dei prodotti.

| file di opzione PDF dovrebbero essere installati
automaticamente quando si apre il file. In caso contrario, &
possibile installarle manualmente:

Adobe InDesign

1. Andare a Selezionare File > Adobe PDF Presets >
Definisci.

2. Cliccare su Carica e selezionare il file .joboptions.

3. Esportail tuo file, seleziona le impostazioni di Lulu
dall'elenco a discesa "Adobe PDF Preset" per esportare
in formato PDF utilizzando le impostazioni delle Job
Options.

LULU GUIDA ALLA CREAZIONE DI UN LIBRO INVIO DEL FILE
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Adobe Photoshop

1. Vai a: Modifica > Adobe PDF Presets.

2. Fare clic su Carica e selezionare il file joboptions.

3. Utilizzare “Salva come PDF di Photoshop” e selezionare
le impostazioni .joboptions dal menu a discesa.

J< Adobe Acrobat Distiller
1. Vai a:Impostazioni > Aggiungi le impostazioni di Adobe
PDF.
2. Navigare al file joboptions e fare clic su OK.
3. Le nuove impostazioni saranno disponibili nell'elenco
a discesa “Impostazioni predefinite”. Assicuratevi di
selezionarle prima di importare il file Postscript (.PS)

Specifiche per il file del contenuto

Quando creiil tuo libro con Lulu, devi fornire un PDF unico con tutti gli
elementi del contenuto. Sono incluse la pagina del titolo e del copyright, oltre
alle eventuali pagine vuote che desideri inserire.

¢ Layout con orientamento verticale a pagina singola

* | eimmaginiincorporate devono avere una risoluzione compresa tra 300
PPI (minima) e 600

PP

* Le immagini vettoriali devono essere rasterizzate

e Tuttii caratteri devono essere correttamente incorporati

* | layer trasparenti e gli oggetti vettoriali devono essere appiattiti
uniformi

* | e pagine sono dimensionate in base alle dimensioni del libro: includi
le dimensioni dei margini al vivo (0,125" oppure 3,175 mm) insieme alle
dimensioni della pagina PDF:
Esempio: un libro di 6" x 9" richiede un PDF con pagine di dimensioni
paria 6,25"x 9,25" (158,75 x 234,95 mm) per rispettare i requisiti di
stampa dei margini al vivo
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* Consenti un margine di sicurezza minimo di 0,50" (12,7 mm) per tuttii
contenuti

* Consentiun minimo di 0,20" (5,08 mm) per il margine del bordo interno
di tutte le pagine

* NON includere linee di taglio, indicatori di pagina al vivo o linee di margini

* Non proteggere il file tramite password/sistema di sicurezza

Specifiche del file della copertina

La copertina deve essere un PDF unico che include tutto il contenuto della
copertina. Lulu fornira un modello di copertina con le dimensioni esatte del
dorso dopo che avrai caricato il PDF del contenuto. Ti consigliamo vivamente
di utilizzare questo modello per garantire che il PDF della copertina venga
stampato e ritagliato correttamente.

* Leimmagini integrate hanno una risoluzione compresa tra 300 PPI
(minima) e 600 PPI

* Le immagini vettoriali devono essere rasterizzate

 Tuttii caratteri devono essere correttamente incorporati

* | layer trasparenti e gli oggetti vettoriali devono essere appiattiti
uniformi

* Le pagine devono essere dimensionate in base alle dimensioni del libro
previste: consulta pagina 13 per il calcolo della larghezza del dorso

* Includile dimensioni al vivo (0,125") (3,175 mm) nella dimensione delle
tue pagine in PDF

* Consenti0,5" 12,7 mm) come margine di sicurezza per tutti i contenuti

* NON includere linee di taglio, indicatori di pagina al vivo o linee di margini

* Non proteggere il file tramite password/sistema di sicurezza
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Copertine di riviste e giornali a fumetti

Se vuoi creare una rivista o un giornale a fumetti, hai la possibilita di stampare
anche sulla parte interna della copertina e della quarta di copertina. Questa
modalita di stampa richiede un file della copertina a due pagine. Per ulteriori
informazioni, consulta la sezione relativa al modello di copertina per riviste e
giornali a fumetti.

Correzione

Forse una delle fasi piti importanti (e spesso trascurata) del processo
editoriale & l'approvazione della bozza finale. Cio significa che avrai caricato,
stampato e ricevuto una copia fisica del tuo lavoro come se fossi un
comune lettore. La correzione del materiale stampato € fondamentale per
la risoluzione dei problemi e I'identificazione degli errori. Alcuni problemi
rilevabili durante la correzione includono:

Errore umano

Avolte, quando silavora con una scadenza, non si ha il tempo dirivedere
completamente il file completato prima di inviarlo in stampa. Dopo aver
ricevuto la copia di prova, potresti notare errori di battitura o problemi
diformattazione. La soluzione migliore € quella di modificare il file del
contenuto, ricaricarlo e ordinare una nuova copia di prova.

Errore del file

La bassa risoluzione dellimmagine, le trasparenze e i caratteri non
incorporati sono problemi comuni che possono non risultare evidenti
quando visualizzi il tuo manoscritto su uno schermo. Anche se il nostro
sistema rileva e corregge molti di questi problemi, alcuni possono sfuggirci.
Se nel libro stampato individui un errore non presente nella versione digitale
del tuo file, contatta il supporto per ricevere assistenza.
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Variazione di stampa

Tuttii produttori cercano di realizzare prodotti precisi al 100%. Tuttavia,
come per qualsiasi altro processo meccanico, esistono dei parametri di
tolleranza da tenere in considerazione. La nostra tolleranza dirifinitura &
paria a 0,125" (3,175 mm) per la copertina e la quarta di copertina. Progettare
il contenuto tenendo presenti variazioni e margini sufficienti ti aiutera a
evitare problemi con l'allineamento del testo del dorso e con eventuali
porzioni di testo tagliate lungo i bordi del contenuto.

Errore di produzione o spedizione

Il nostro obiettivo € stampare, rilegare e consegnare libri della massima
qualita possibile; tuttavia, a causa della natura della produzione di libri su
misura, non possiamo garantire la perfezione assoluta di ogni libro. Se il
tuo libro risulta piegato, strappato, danneggiato o presenta altri difetti di
produzione o di spedizione, contattaci all'indirizzo contatta il supporto per

ricevere assistenza.

Klulu
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